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Section 1: Introduction and Specifications 
 
1.1  Q-DL-2100 Datalogger Platform 
 
The Q-DL-2100 datalogger platform consists of: 

1. a Microcontroller containing specialized firmware  
2. a Real-Time Clock  
3. an Analog Input subsystem 
4. an Analog Output subsystem 
5. a Digital Input/Output subsystem 
6. Redundant Data Storage, containing 

a. a user-removable SD card 
b. a non-removable Micro SD card  

7. RS-232 interfaces for communicating with PCʼs, sensors, or other equipment 
8. SDI-12 interfaces, typically used for communicating with environmental sensors 
9. Regulated 5V and 12V outputs 
10. Relays which can be user configured and controlled 
11. Integrated Temperature, Humidity and Pressure sensors. 
12. A Remote communications subsystem, containing  

a. an Optional Internal GSM or CDMA cell phone modem  
and/or  
b. an Optional Internal Iridium satellite modem 

 
1.2  Q-DL-2100 Datalogger Options 
 
The Base Model Number of the Q-DL-2100 units is:   

Q-DL-2100 
 

Several remote communications options are available: 
-G   GPRS (GSM) Integrated Cell Phone Modem.   
-C  CDMA Integrated Cell Phone Modem  
- I  Integrated Iridium Satellite Modem  
*The Q-DL-2100 may contain both a Cell Phone Modem and an Iridium modem. i.e., 
a Q-DL-2100-GI model number would indicate the unit contains both an integrated 
GSM modem and an integrated Iridium modem, whereas a Q-DL-2100-I would 
indicate the unit contains only an integrated Iridium modem.   
** An integrated cell phone modem, Iridium modem, or both can be added to the 
datalogger at any time.  Contact Quaesta Instruments LLC for pricing and details.  

 
A Q-DL-2100 platform data logger with an integrated Iridium modem would have a model 
number of Q-DL-2100-I. 
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1.3  Q-DL-2100 Datalogger Specifications 
• Microcontroller based. 
• Program Execution Rate: 

o 1 min to 1 yr, in 1 minute increments.  
• Analog Inputs: 

o 4 Single-Ended inputs. 
o 0 to 5V range. 
o 2.5 µ V resolution (21 bits) 
o Integrated 50Hz or 60Hz noise suppression (Factory settable) 
o Conversion time for single channel measurement: 

• ~130 ms for 60 Hz suppression 
• ~150 ms for 50 Hz suppression 

o Aggregrate Attainable ADC Data Rate:  
• 5 Hz.  

• Analog Outputs: 
o 4 independent 16 bit DAC outputs  
o 0 to 5V range 
o ~ 0.08 mV  resolution 

• Digital I/O Ports: 
o 4, each individually configurable as TTL input, TTL output, or TTL counter 

• Relays: 
o 4 solid-state, each rated for 30 Volts DC @ 1.2Amps 

• Relative Humidity Sensor with Temp 
o 1 integrated,  

 RH Resolution = 0.05%  
 RH Accuracy ~ 3% over the 20% to 80% RH range. 
 Temp Resolution ~ 0.5 deg C 
 Temp Accuracy  ~ 1 deg  

o 1 external , characteristics as internal   
• Temperature Sensor: 

o 1 integrated,  
 Range -55 C to + 125 C 
 Resolution = 0.35 deg C,  
 Accuracy = 0.5 deg C (from -10C to +85C) 

o Multiple external, up to 16 sensors  
• Barometric Pressure Sensor 

o 1 Integrated, with hose barb connection for external pressure monitoring 
o 0.1 mbar resolution 
o Calibratable with simple offset pressure calibration number 

• Switched Regulated Power Outputs 
o 5 V 
o 12V 

• Real-Time Clock 
o Clock Accuracy:  3 min per year  

 May be automatically updated via satellite if Iridium satellite remote telemetry option is chosen 
• Sensor Communications Support 

o RS-232, 2 Ports 
o SDI-12,  2 Ports,Up to 10 SDI sensors per port. 

• Remote Telemetry Support 
o Integrated Iridium Satellite Modem (-I option).   
o Integrated Cell Modem -GPRS (-G option) or CDMA (-C option) capable.   
o Datalogger can respond to remote commands sent via simple email in the case of Iridium service and 

simple text messages in the case of Cell Phone modem service.  
• Data Storage 

o 1 user removable SD card 
o 1 non-removable Micro SD card, for redundant data storage 
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Q-DL-2100 Datalogger Specifications, cont. 
• Power Requirements 

o Voltage: 6  to 26 V DC 
Note: Voltage greater than 12.3 V required to use fully regulated 12V output.  

o Typical Current Drain:  
Idle Mode:  ~ 10 mA  
Note: 7 mA is quiescent current of Integrated pressure sensor.   

 Can be powered from 12V or 24V solar panels.  
• Datalogger Configuration  

o Via simple to use QILogger.ini text file on external SD card. 
o Via USB or RS232 port and terminal program such as Windows hyperterminal or Teraterm.  
o Via PC based software with RS232 communications control  

Note:  Quaesta Instruments GUI driven PC based software in development  
• Physical Specifications 

o Dimensions: 7 ½ in. x 6 ¾ in. x 2 ¼ in. 
o Rugged extruded aluminum housing 

• Additional Features: 
o Input Power is monitored and optionally recorded if desired. 
o Power Conservation modes.  Can be easily configured to enter power saving  mode when: 

• Input Power Voltage level drops below a user-settable threshold 
 Daily power down time occurs (will then leave power saving mode when Daily Power Up time 

occurs). 
• Neutron Pulse Module (Q-NPM-1000) support 

o The Q-NPM-1000 is a Quaesta Instruments neutron pulse module designed to interface directly 
with neutron counting gas tubes, either of the Helium-3 (He3)  or  Boron Trifluoride (BF3 )type.  

o Multiple Q-NPM-1000 modules may be connected to a Q-DL-2100 datalogger, allowing  for 
completely autonomous and unattended Neutron counting and logging.  
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1.4  Q-DL-2100 Datalogger Front Panel Layout 
 

 
FIGURE 1-1 

 
Power Input: 

2.5 X 5.7MM barrel type power jack.  Nominal 12V required.  6 - 26 V DC is allowed.  
A voltage greater than 12.3 VDC must be utilized to enable a fully regulated 12V DC 
output (5V and 12V regulated power outputs are available from the back panel). 
 

On/Off : 
 Power may be toggled with the On/Off Switch 
 
LEDs: 

P:  Heartbeat LED.  Flashes at a nominal cadence of once every 8 seconds while 
idle, once every second while not idle. 

Q: Data Acquistion indicator LED.  Illuminates during data acquisition and data 
storage process. 

 
RJ-45 Interface Connectors: 
 Two jacks, labeled A and B, are provided.  
 Standard RJ-45 jacks are employed.  
 
SD/MMC: 
 Standard SD card slot, Push In/Push Out type socket. 
 
Com: 
 Terminal type Communication via USB is supported (with appropriate PC drivers) 
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1.5  Q-DL-2100 Datalogger Back Panel Layout 
 

 
FIGURE 1-2 

 
RJ-45 Connectors are utilized for the Analog Out, Analog In, Digital I/O and Sensor 
subsystems as well as for Relays and RS-232 interfaces:  

Standard Ethernet cable and connectors may be used. 
 

Regulated 5V Output: 
 1.0 X 4.2MM barrel type power jack.  The 5V regulated output may be turned ON/OFF 
via the appropriate datalogger INI parameter. 
 
Regulated 12V Output: 
 1.3 X 4.2MM barrel type power jack.  Note that 12.3V DC or greater must be supplied 
to the datalogger Power input to enable the full 12V regulated power output.  The 12V 
regulated output may be turned ON/OFF via the appropriate datalogger INI parameter. 
 
Iridium Satellite Modem Antenna Connection: 
 - For dataloggers with an integrated Iridium satellite modem, a standard SMA female 
connector is present for connecting a user supplied Iridium antenna.  Quaesta Instruments 
can provide the antenna and cable or suggest an appropriate supplier.  Contact Quaesta 
Instruments for pricing and details.  
 
Barometer: 
 -An integrated barometer is present. A hose barb allows for pressure monitoring at 
some distance from the datalogger.  
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1.6  Q-DL-2100 Electrical Connections: Back Panel 
  
RJ45 modular 8 pin, 8 conductor Jacks are located on the Back Panel for the Analog Out, 
Analog In, and Digital I/O subsystems as well as the Sensors, Relays, and RS-232 interface 
connectors.   Standard ethernet patch cable with an RJ45 modular 8 pin, 8 conductor Plug 
may be used.   The cable jacket and individual wire insulation may be easily stripped at the 
other end to facilitate connections to other equipment.   As many different grades of ethernet 
cable are available, it is recommended that good solid conductor ethernet cable is utilized for 
reliability in the field.  The solid conductor cable is also easier to strip than the stranded 
conductor type.  
 
Patch cable with EIA/TIA 568A and EIA/TIA 568B type connections are available.   The more 
commonly available today is patch cable made with EIA/TIA 568B type connections.  For the 
userʼs convenience, diagrams for each of these standards is included below as well as the 
pin positions for the RJ45 plug.  
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1.6  Q-DL-2100 Electrical Connections: Back Panel,  cont. 
 
Below is a table of pinouts for the RJ45 connectors on the back panel and the corresponding 
wire colors for an EIA/TIA 568B type patch cable.   Appropriate changes should be made if 
an EIA/TIA 568A type patch cable is used instead. 
 
Table 1.1    RJ45 Connector wiring diagram for EIA/TIA 568B type patch cable. 
ANALOG OUT 
1A Ground   Orange/White 
2A AnalogOut-1  Orange 
3A Ground   Green/White 
4A AnalogOut-2  Blue 
5A Ground   Blue/White 
6A AnalogOut-3  Green 
7A Ground   Brown/White 
8A AnalogOut-4  Brown 
 
ANALOG IN   NOTE:  5 Volts Maximum 
1B Ground   Orange/White 
2B AnalogIn-1  Orange 
3B Ground   Green/White 
4B AnalogIn-2  Blue 
5B Ground   Blue/White 
6B AnalogIn-3  Green 
7B Ground   Brown/White 
8B AnalogIn-4  Brown 
 
DIGITAL I/O 
1C Ground   Orange/White 
2C DigitalI/O-1  Orange 
3C Ground   Green/White 
4C DigitalI/O-2  Blue 
5C Ground   Blue/White 
6C DigitalI/O-3  Green 
7C Ground   Brown/White 
8C DigitalI/O-4  Brown 
 
SENSORS 
1D Ground   Orange/White 
2D 5 Volts   Orange 
3D Ground   Green/White 
4D External Temp Sensor  Blue 
5D Ground   Blue/White 
6D Humidity Sensor Clock Green 
7D Ground   Brown/White 
8D Humidity Sensor Data  Brown 
 
RELAYS   NOTE:  30V, 1.2A Maximum 
1E RelayB-1   Orange/White 
2E RelayA-1   Orange 
3E RelayB-3   Green/White 
4E RelayA-2   Blue 
5E RelayB-2   Blue/White 
6E RelayA-3   Green 
7E RelayB-4   Brown/White 
8E RelayA-4   Brown 
 
RS-232   NOTE:  TX and RX are with respect to the Data Logger 
1F Ground   Orange/White 
2F TX - A   Orange 
3F Ground   Green/White 
4F RX - A   Blue 
5F Ground   Blue/White 
6F TX - B   Green 
7F Ground   Brown/White 
8F RX - B   Brown 
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Section 2: Datalogger Operation 
 
2.1  Installation 

 
To install the Q-DL-2100 datalogger unpack the datalogger and follow these steps. 
 
1.  Configure the QILogger.ini located on the external SD card as appropriate and as 
described in detail in Section 2.2 below.  This file can be edited via a simple word processor 
such as Wordpad or Notepad on a Microsoft Windows based PC. 
2.  Provide power to the datalogger via the Power Jack on the front panel.  One may utilize 
nominal 12V DC power supplied from an AC adapter or from a battery source.  
3.  Switch on the datalogger.  

- The dataloggerʼs heartbeat LED should first flash at a cadence of several flashes per 
second for nominally 5 seconds.  Then the datalogger firmware will configure the 
datalogger using INI parameters as found in the QILogger.ini file located on the external 
SD card.    Next, the datalogger will execute a self test of the data acquisition system, 
after which time the heartbeat LED will begin flashing at a cadence of approximately once 
every 8 seconds. 

 
2.2  Data Logger Configuration 
 
The Q-DL-2100 datalogger is configured for operation via a set of simple INI parameters.  
At power on, the datalogger attempts to read and load these parameter settings from a 
QILogger.ini text file located on the external SD card.  If the QILogger.ini file is present then 
parameter settings are obtained from the file and the file is copied to the internal SD card.  If 
the QILogger.ini file is not present on the external SD card, then the datalogger will attempt to 
read and load parameter settings from the current version of the QILogger.ini text file located 
on the internal SD card.   If no QILogger.ini file is found on either the external or internal SD 
cards, then the datalogger will utilize default values for the INI parameters. 
 
The INI parameters will be described in detail below. 
 
The dataloggerʼs INI parameters may be changed or edited in several ways: 

1. via direct editing of the INI parameter fields in the QILogger.ini text file located on the 
user-removable Secure Digital (SD) card 

2. by setting of the INI parameter fields through a simple Terminal interface program 
such as Windows Hyperterminal or Tera Term Pro. 

3. by remote telemetry, via email or text message depending on the telemetry option 
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2.3  INI Parameters Description 
 
Q-DL-2100 INI file parameters (Not Case Sensitive) 
  
Name= ?  - Name of the Logger: e.g. 'name= QILogger'(16 max) 
Extension= ? - Extension of the filename: e.g. 'extension= 005'(3 chars max)  
 *The extension of the data filenames written to the SD media 

    
// Data Acq Params  
StartTime= ?  - Time to start logging (YYYY/MM/DD HH:MM:SS);  
 e.g. 'starttime= 2009/07/04 14:30:00  
StopTime= ?  - Time to stop logging (YYYY/MM/DD HH:MM:SS);  
 e.g. 'stoptime= 2019/01/01 01:00:00  
RecordPeriod=?  - Record period in minutes: e.g. 'Recordperiod=15' 

*This is the interval at which data is sampled and recorded on the   Secure 
Digital card. 

DataSelect= ?  - Select Data to save:  
 e.g. 'dataselect= p1t1h1b1n1n2' 
 p1=Internal Press Sensor, t1=intern temp h1=intern RH,  
 b1=Power Supply Voltage,  
                            n1=1st NPM cts, n2=2nd NPM cts, n3=3rd NPM cts, etc 
 t2=extern temp, h2=extern RH 
 aN=Analog Input Chan N, N= 1 to 4, e.g. a2 selects Analog Input Ch2 
 dN=Digital Input Chan N, N= 1 to 4, e.g. d3 selects Digital Input Ch3 
 
//Analog Input Configuration Params 
AdcCalN= ?.??? - N= ADC Chan #, Calibration Multiplier for ADC Channel N  
 e.g. 'AdcCal1= 1.3' 
Pcal= ?.?  - Barometric Pressure calibration offset, millibars: e.g. 'Pcal= 8.9' 

* This is an additive number. i.e., if the Pressure is reading low by 10.2 mbars, 
then set Pcal 10.2 mbars higher than its current value. 

 
//Digital I/O Configuration 
DioN= ?  - N= Digital I/O Chan: ? -> 1=CTR mode, 2=Output, 3=Input.  
 e.g. ʻDio2=1ʼ 
 
//Neutron Pulse Module Configuration 
NumberOfNPMs= ? - Number of Neutron Pulse Modules (NPMs) in Use 
 
// DAC Output Mapping  
DACMappingOn= ?  - Turns OFF/ON DAC Mapping  

*makes DAC out proportional to given input) 
DAC?=?? * ?.???? - Map Dac? value, e.g. 'Dac3= T1 * 0.128'.   

*Active only if DACMappingOn=1. 
 
// Relays and Regulated Power Outputs 
Relays=?  - Relays activated bitwise:  e.g. 
  ʼRelays = 1ʼ, Relay 1 activated, Relay 2 deactivated 
  ʼRelays = 2ʼ, Relay 1 deactivated, Relay 2 activated 
 ʼRelays = 3ʼ, both Relay 1 and Relay 2 activated 
 ʼRelays = 15ʼ, all 4 relays activated 
Pwr5VOn=?  - Turns OFF/ON regulated 5V output 
Pwr12VOn=?  - Turns OFF/ON regulated 12V output 
PwrNPMOn=?  - Turns OFF/ON Neutron Pulse Modules 
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// Power Conservation Configuration 
// -----These params are active only if Battery Thresholding  
// -----is On or Daily Power Conservation is On 
 
Conserve5VPwr= ?  - Turns OFF/ON 5V Regulated Power Conservation, 0 or 1 
Conserve12VPwr= ?  - Turns OFF/ON 12V Regulated Power Conservation, 0 or 1 
ConserveNPMPwr= ?  - Turns OFF/ON NPM Power Conservation, 0 or 1 
 
// Battery Thresholding 
BatteryThresholdsOn= ? - Turns OFF/ON Battery Thresholding, 0 or 1 
LowBatteryThresh= ?.??  - Battery voltage below which logger will enter power saving mode 
   e.g. LowBatteryThresh=11.5 
ChargedBatteryThresh= ? - Battery voltage above which logger will leave power saving   mode 
   e.g. ChargedBatteryThresh=12.5 
 
// Daily Power Up and Down Times - see ConservePwrXXX params above 
DailyPwrConserveOn= ? - Turns OFF/ON Power Conservation by Time, 0 or 1 
DailyPowerUpHHMM= ?  - Sets Power Up Time  for each day (leaving Power  Conservation 

Mode) 
   e.g. ʻDailyPowerUpHHMM=0630ʼ 
DailyPowerUpHHMM= ?  - Sets Power Down Time  for each day (entering Power  Conservation 

Mode) 
    e.g. ʻDailyPowerDownHHMM=2130ʼ  
 
// Remote Communications 
UseRS232= ?    - Turns OFF/ON Use of external RS232 ports, 0 or 1 
RS232BaudRate= ? - Baud Rate for External RS232 Ports (best if 19200 or above) 
UseSatModem= ?   - Turns OFF/ON Use of Iridium Sat Modem, 0 or 1  
 
// Satellite Modem Communication  
//    Only active if UseRS232=0 and UseSatModem=1 
//    Iridium Satellite Modem must be present and Activated.  
RecordsPerSatTrans= - Number of RecordPeriods before Sat Trans Attempted 
MaxRapidSatSigQueries= - Number of Sat Sig Strength Queries before Sat Siq Query aborted 
SatRetryPeriod_Minutes= - Number of Minutes to wait for subsequent Trans attempts after 

failures 
SatTransPersistence= - Number of Sat Trans Retries Before Trans Aborted, 1 to 3 
UpdateTimeViaSat=  - Turns OFF/ON Updating of Logger Real Time Clock with  
    Iridium Satellite Network Time, 0 or 1 
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2.4  Sample QILogger.ini file 
 
The QILogger.ini file located on the external SD card may be edited directly via Wordpad or 
Notepad or other suitable text editor.  Care should be taken to maintain the parameterʼs 
spelling.  An equal sign or a space, or a combination of spaces and equal signs, between the 
parameter and its desired value are acceptable. 
 
Below is an example of a QILogger.ini file. 
-------------------------------------------------------------------------- 
/** Hydroinnova CRS-1000 Cosmic Ray Probe**/ 
/** Q-DL 2100 Datalogger INI file**/ 
/** FW Version 1.24 **/  
 
Name=COSMOS 
Extension=002 
 
// Data Acq Params  
//  Format for Start and Stop Acq Times is YYYY/MM/DD HH:MM:SS or YY/MM/DD HH:MM:SS 
Starttime= 2009/09/09 12:00:00 
Stoptime= 2031/01/08 17:00:00 
Recordperiod=60 
DataSelect=p1t1h1b1n1n2 
 
// Analog Input Configuration 
AdcCal1=1.2500000 
AdcCal2=2.3000000 
AdcCal3=0.9907000 
AdcCal4=12.500000 
Pcal= -7.2 
 
// Digital I/O Configuration  
Dio1=1 
Dio2=1 
Dio3=3 
Dio4=2 
 
// Neutron Pulse Module Configuration 
NumberOfNPMs=2 
 
// DAC Output Mapping  
DACMappingOn=1 
DAC1=P1* 0.003000 
DAC2=T1* 0.08000 
DAC3=P1* 0.00000 
DAC4=P1* 0.00000 
 
// Relays and Regulated Power Outputs  
Relays=0 
Pwr5VOn=0 
Pwr12VOn=1 
PwrNPMOn=1 
 
// Power Conservation Configuration 
// -----These params are active only if Battery Thresholding  
// -----is On or Daily Power Conservation is On 
Conserve5VPwr=1 
Conserve12VPwr=1 
ConserveNPMPwr=1 
 
// Battery Thresholding 
BatteryThresholdsOn=0 
LowBatteryThresh=11.5 
ChargedBatteryThresh=12.6 
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2.4 Sample QILogger.ini file, cont. 
 
// Daily Power Up and Down Times - see ConservePwrXXX params above 
DailyPwrConserveOn=0 
DailyPwrUpHHMM=0600 
DailyPwrDownHHMM=2000 
 
// Remote Communications 
UseRS232=1 
RS232BaudRate=19200 
UseSatModem=0 
-------------------------------------------------------------------------- 
 
The above QILogger.ini file configures the Datalogger and Data acquisition as 
follows: 
 
//Names and Filename Extensions 

Extension=002, sets the filename extension for the text data files on the SD media  
 
//Data Acq Params 

Starttime= 2009/09/09 12:00:00,  Sept 9, 2009 at 12:00 PM (24 hour format is used for 
the Starttime parameter). If this time is earlier than the current Real Time Clock time, then 
acquisition begins immediately.  If the Real Time Clock time is not between the Starttime and 
Stoptime parameters, then the datalogger will display on the terminal interface the “Data NOT 
recorded at YYYY/MM/DD HH:MM:SS” at each elapsed recordperiod in minutes. 

Stoptime= 2031/01/08 17:00:00, Jan 8, 2031 at 5:00 PM (24 hour format is used for the 
Stoptime parameter).   If the Real Time Clock time is not between the Starttime and Stoptime 
parameters, then the datalogger will display on the terminal interface the “Data NOT recorded 
at YYYY/MM/DD HH:MM:SS” at each elapsed recordperiod in minutes. 

Recordperiod=60, indicates that data will be sampled and recorded to the dataloggerʼs 
SD storage media every 60 minutes.  (Note that timestamps are written to the data files as 
well).  

DataSelect=p1t1h1b1n1n2, indicates that at the end of each elapsed recordperiod, the 
dataloggerʼs integrated Pressure, Temperature and Humidity sensors will be sampled along 
with the Power Supply Voltage and the counts from two NPMs (neutron pulse modules). 

 
//Analog Input Configuration 

AdcCal1=1.2500000 
AdcCal2=2.3000000 
AdcCal3=0.9907000 
AdcCal4=12.500000 

The scale factors for each ADC input channel are set. For example, if 1.000 volt is 
present at the ADC channel 4 input, then 12.500000 would be recorded as the value 
of the ADC input channel 4.  

Pcal= -7.2 
An offset of -7.2 mbars is added to the Pressure sampled by the dataloggerʼs 
integrated Pressure sensor.  Thus, if the pressure sensor reads 727.2 mbar directly, 
then 720.0 mbars will be reported and recorded as the calibrated pressure.  
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2.4  Sample QILogger.ini file, cont 
 
//Digital I/O Configuration 

Dio1=1 
Dio2=1 
Dio3=3 
Dio4=2 

Digital I/O channels 1 and 2 are configured as counters while channels 3 and 4 are 
configured as a Digital Output and a Digital Input, respectively.  

 
// Neutron Pulse Module Configuration 

NumberOfNPMs=2 
 The number of Neutron Pulse Modules present in the Probe is set to 2.  The current 
version of the datalogger firmware supports from 0 to 4 Neutron Pulse Modules.  
 
// DAC Output Mapping  

DACMappingOn=1 
DAC1=P1* 0.003000 
DAC2=T1* 0.08000 
DAC3=N1* 0.01000 
DAC4=N2* 0.01000 

 The DACMappingOn INI parameter allows one to produce Analog Outputs 
proportional to Inputs sampled by the datalogger. i.e., with the parameters as above, Analog 
Output Channel 1 will be a voltage output equal  to (P1 in mbar)*0.003, Analog Output 
Channel 2 will be a voltage output equal to (T1 in deg C)*0.08, Analog Output Channels 3 
and 4 will be a voltage equal to Neutron Pulse Module Counts (N1*0.01) and (N2*0.01), 
respectively.   
 *Note that the maximum value of the Analog Output voltage is 5V DC, so the scaling 
constants used should be such that 5V is not obtained over the expected  range of the 
parameter to be mapped.  
 
// Relays and Regulated Power Outputs  
  Relays=0 
  Pwr5VOn=0 
  Pwr12VOn=1 
  PwrNPMOn=1 
      All relays are OFF (deactivated). 
      5V Regulated Power Output is OFF (disabled). 
      12V Regulated Power Output is ON (enabled). 
 Neutron Pulse Module Power is ON (enabled). 
 
// Power Conservation Configuration 
// -----These params are active only if Battery Thresholding  
// -----is On or Daily Power Conservation is On 
  Conserve5VPwr=1 
  Conserve12VPwr=1 
  ConserveNPMPwr=1 

5V and 12V Regulated Power, as well as NPM Power, will be conserved if Battery 
Thresholding or Daily Power Conservation is On
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// Battery Thresholding 
  BatteryThresholdsOn=1 
  LowBatteryThresh=11.5 
  ChargedBatteryThresh=12.6 

Battery Thresholding is ON, so Power Conservation mode will be entered when the 
dataloggerʼs power supply voltage drops below 11.5 V.  Likewise,  after Power 
Conservation mode is entered, Power Conservation mode will only be exited when a 
power supply voltage greater than 12.6 V is obtained.  

 
// Daily Power Up and Down Times - see ConservePwrXXX params above 
  DailyPwrConserveOn=0 
  DailyPwrUpHHMM=0600 
  DailyPwrDownHHMM=2000 

Daily Power Conservation is OFF, but had it been set to ON,  Power Conservation 
mode would be entered each day at 20:00 and exited at 6:00 the next morning.   

 
// Remote Communications 
  UseRS232=1 
  RS232BaudRate=19200 
  UseSatModem=0 

The RS-232 interface has been selected for monitoring of the datalogger and its data 
– the datalogger will treat the RS-232 interface as a terminal interface. 

 The Baud Rate is set to 19200 baud.  
 The integrated Iridium satellite modem, if it exists, is Disabled. 
 
 
2.5  Modifying the INI parameters via the Terminal interface 
 
All of the datalogger INI parameters described above can be set via the command line of an 
interactive Terminal interface with the datalogger.  
 
i.e., typing  ʻBatteryThresholdsOn=0ʼ will turn OFF Battery Thresholding. 
       typing ʻRecordperiod=30ʼ will cause data indicated by the Dataselect INI parameter to be 
sampled and recorded each time a recordperiod number of minutes elapses. 
 
Each time an INI parameter is successfully changed the current list of INI parameters will be 
displayed in the same format as that of the the QILogger.ini text file.  
 
Typing ʻshowiniʼ will display a list of all user configurable INI parameters and their values.  
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2.6  Terminal Interface Command Set 
 
When utilizing a terminal interface program to communicate with the datalogger, one can 
type ʻmenuʼ to see a list of both the available commands and the available INI parameters. 
i.e., in HyperTerminal window or Tera Term Pro terminal interface window, type ʻmenuʼ  
 
Result: 
 
menu 
 
***List of available Commands (Not Case Sensitive)*** 
 
Test             - Confirms Logger operation. Returns 'OK it works!'. 
WriteINI         - Write current INI values to the currently selected SD card 
ReadINI          - Read INI values from the currently selected SD card 
ShowINI          - Show current INI values 
ShowTime         - Show Date,Time 
ShowCntVars      - Shows Minute Counter Values, Time 
ShowData         - Show all of the data seleced by the DataSelect INI parameter. 
ShowFilename     - Shows the current data Filenames for SD storage 
SetTime          - Set the current time. User is prompted to follow instructions 
StartLog         - Start logging data. Check Starttime and Stoptime INI parameters. 
StopLog          - Stop logging data. Turns off Real Time Clock interrupts. 
//SD Card Commands 
  C:               - Selects the Internal SD Card 
  D:               - Selects the External SD Card 
  Dir              - Show the files on the Current memory card 
  Type             - Show the contents of a file: 'type 04231050.001' 
  Del              - Delete a file: 'del 04231050.001' 
//Sat Modem Commands 
  SatModemOn       - Turn ON Satellite Modem (if INI param UseSatModem = 1) 
  ShowSatModemSig  - Display Sat Sig Strength. (if INI param UseSatModem = 1). 
      -Hit any key to quit ShowSatModemSig Query (takes a few seconds) 
  ShowSatModemIMEI - Display Iridium Sat Modem IMEI #. 
  SatModemOff      - Turn OFF Satellite Modem 
Menu             - Show what you see here 
A/               - Repeat the previous command 
 
***List of available INI parameters (Not Case Sensitive)*** 
 
Name= ?                - Name of the Logger: e.g. 'name= QILogger'(16 max) 
Extension= ?           - Extension of the filename: e.g. 'extension= 005'(3 max) 
StartTime= ?           - Time to start logging (YY/MM/DD HH:MM:SS); e.g. 

'starttime= 09/07/04 14:30:00' 
StopTime= ?            - Time to stop logging: (YY/MM/DD HH:MM:SS); e.g.  

'stoptime= 09/10/11 12:13:14' 
Recordperiod= ? - Cadence in minutes for Data Acquisition and Storage of   

Data on the datalogger’s SD storage media. 
DataSelect= ?          - Select Data to save: e.g. 'dataselect= p1t1h1b1n1n2' 

p1=Internal Press Sensor, t1=intern temp, h1=intern RH, 
b1=Power Supply Voltage, n1=1st NPM cts, n2=2nd NPM cts 

    t2=extern temp, h2=extern RH 
aN=Analog Input Chan N, N= 1 to 4, e.g. a2 selects Ch2 

     dN=Digital Input Chan N, N= 1 to 4, e.g. d3 selects Ch3  
AdcCalN= ?.???         - N= ADC Chan #, Calibration Multiplier for ADC Channel N: 

e.g. 'AdcCal1= 1.3' 
Pcal= ?.?              - Barometric Pressure calibration offset, millibars:  

e.g. 'Pcal= -8.9' 
DioN= ?                - N= Digital I/O Chan: ? -> 1=CTR mode, 2=Output, 3=Input. 

e.g. Dio2=1 
NumberOfNPMs= ?        - Number of Neutron Pulse Modules (NPMs) in Use 
DACMappingOn= ?        - Turns OFF/ON DAC Mapping (makes DAC out proportional to 

given input) 



Q-DL-2100 Operatorʼs Manual    

Quaesta Instruments, LLC   (520) 449-3806   •  Email: support@quaestainstruments.com 19 

DAC?= ?? * ?.???     - Map Dac? value, e.g. 'Dac3= T1 * 0.1'.  Active only if 
DACMappingOn=1. 

Relays= ?              - Which of 4 Relays activated: e.g. 'Relays= 15', all relays 
activated 

Pwr5VOn= ?             - Turns OFF/ON regulated 5V Power Output 
Pwr12VOn= ?            - Turns OFF/ON regulated 12V Power Output 
PwrNPMOn= ?            - Turns OFF/ON Neutron Pulse Modules 
Conserve5VPwr= ?       - Turns OFF/ON 5V Regulated Power Conservation, 0 or 1 
Conserve12VPwr= ?      - Turns OFF/ON 12V Regulated Power Conservation, 0 or 1 
ConserveNPMPwr= ?      - Turns OFF/ON NPM Power Conservation, 0 or 1 
BatteryThresholdsOn= ? - Turns OFF/ON Battery Thresholding, 0 or 1 
LowBatteryThresh= ?    - Battery voltage at which logger enters power saving mode 
ChargedBatteryThresh= ?- Battery voltage at which logger exits power saving mode 
DailyPwrConserveOn= ?  - Turns OFF/ON Scheduled Power Conservation, 0 or 1 
DailyPowerUpHHMM= ?    - Sets Power Up Time for each day (leaving Power 

Conservation Mode) 
DailyPowerDownHHMM= ?  - Sets Power Down Time for each day (entering Power 

Conservation Mode) 
UseRS232= ?            - Turns OFF/ON Use of external RS232 ports, 0 or 1 
RS232BaudRate= ?       - Baud Rate for External RS232 Ports (best if 19200 or 

above) 
UseSatModem= ?         - Turns OFF/ON Use of Iridium Sat Modem, 0 or 1 
RecordsPerSatTrans= ?  - Number of RecordPeriods before Sat Transmission Attempted 
MaxRapidSatSigQueries=?- Number of Sat Sig Strength Queries before Sat Siq Query 

aborted 
SatRetryPeriodMinutes=?- Number of Minutes to wait for subsequent Trans attempts 

after failures 
SatTransPersistence=?  - Num of Sat Trans Retries Before Sat Trans Aborted, 1 to 4 
UpdateTimeViaSat=?     - Turns OFF/ON Updating of Time Via Sat Network Time, 0 or 1 
NPMHistSatSend=?       - Turns OFF/ON Sending of NPM Histograms via Sat, 0 or 1 
 
 
 

The ʻmenuʼ command allows one to quickly display the current list of available commands as 
well as allow one to look at the current INI parameter options.  These commands and 
parameters are likely to change slightly as the Firmware changes so it is probably best and 
easiest to reference the available commands and INI parameters via the ʻmenuʼ command. 
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2.7  Remote Communication 
 
Using Integrated Iridium Satellite modem. 
 Description to be added soon.  
 
Using Integrated Cell Phone modem. 
 Description to be added soon.  
 
Using External Teltonika WirelessCOM/ G10 GSM modem. 
 The Teltonika WirelessCOM/G10 GSM modem allows one to connect to the 
datalogger from a remote location via an IP address.  
 Using appropriate software, such as Hyperterminal or Tera Term Pro, a terminal 
interface connection can be initiated in the same manner as if one was directly connected 
with a PC to either the dataloggerʼs USB COM port or one of its RS-232 interfaces via the 
datalogger backpanelʼs RS-232 connector.  
 
 Follow the directions in the Teltonika documentation for configuring the 
WirelessCOM/G10 device.    Set the parameters as below: 
 Baud Rate:   19200 
 Data Bits:  8 
 Parity:   None 
 Stop Bits:  1 
 Flow Control:   None 
 
The following INI parameters should also be configured: 

UseSatModem=0 
UseRS232=1 
RS232BaudRate=19200 (baud rate must be greater than or equal to 19200) 
 

Connect an appropriate cable between the dataloggerʼs RS-232 interface Jack and the 
Wireless COM/G10 device.  
 
Assuming the datalogger is on and GSM service is available, one should now be able to 
communicate remotely from the datalogger via a terminal emulation program capable of 
TCP/IP communication.  HyperTerminal and Tera Term Pro both support the TCP/IP 
communications interface option. 
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 Appendix A: USB Communication Interface Setup 
 
Setting up the Q-DL-2100 USB Communication interface is easy and straightforward. 
 
Summary: 

1. Obtain the appropriate USB Virtual COM Port Driver .zip file for your PC operating 
system.  

2. Install the Virtual COM Port Driver.  
3. Determine USB Virtual COM Port setting  

 
Detailed Instructions: 
 
Step 1.  Obtain the appropriate USB Virtual COM Port Driver .zip file for 
your PC operating system. 
  
 Future Technology Devices International (FTDI) provides drivers for the USB 
communications interface contained in the Quaesta Instruments data logger products.  The 
USB driver files can be obtained from one of two sources: 1. Quaesta Instruments CD-ROM 
included with the data logger;  2. FTDI web site (It is recommended that the user check the 
FTDI web site for the latest drivers if it has been some time since the data loggers were 
purchased.)  
 
 USB Driver Source 1:  Quaesta Instruments CD-ROM. 
 For convenience, the latest USB Virtual COM Port Driver driver available at the time 
of the data logger shipment can be found on the Quaesta Instruments CD-ROM in the USB 
Drivers folder.    The file is a .zip file.  For a Windows XP, Windows Vista, or Windows 2000 
machine the appropriate zip file will be located in the WinXP_Vista_2000 sub-folder.  For a 
Windows 98 or Windows ME machine the appropriate zip file will be located in the 
Win98_ME subfolder).   Extract the contents of the appropriate zip file to a folder on your 
computer.   Note the location of the folder. 
 
Or,  
 USB Driver Source 2:  FTDI Web Site.   

If desired, the latest available USB Virtual COM Port driver can be found for your 
operating system at the FTDI Virtual COM Port Driver web page:   
http://www.ftdichip.com/Drivers/VCP.htm .  See Figure A-1.  Download and save the file 
appropriate to your operating system to a location on your PC.   Extract the contents fo the 
appropriate zip file to a folder on your computer.  Note the location of the folder.  
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Figure A-1 

 
 
Step 2.  Install the Virtual COM Port Driver.   
 
For convenience a concise and brief guide for installation of the USB Virtual COM Port driver 
utilizing the Windows XP Found New Hardware Wizard is contained below.  
 

Thorough installation guides for Windows XP  , Windows 2000, Windows 98, 
Windows ME, and Mac OSX platforms are also available at the FTDI website at 
http://www.ftdichip.com/Drivers/VCP.htm . 

 
Via a USB cable, connect a USB port on the PC to the Com Port on the Q-DL-2100 panel 
(The data logger power does not need to be on during this step, although it is ok if it is.).   
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When using Windows XP, the Found New Hardware Wizard should activate and display a 
window as shown below in Figure A-2.   
 

 
Figure A-2.  
 
To the question “Can Windows connect to Windows Update to search for software?” Select 
the “No, not this time” option as shown, and click Next.  The window shown in Figure A-3 
should be displayed.   
 

 
Figure A-3
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Select “Install from a list or specific location (Advanced), and click Next. 
The  Window shown below in Figure A-4 should appear.   
 

 
Figure A-4 
 
Select the option button “Search for the best driver in these locations”.  Then clear the 
checkbox “Search removable media (floppy, CD-ROM…)” and select the “Include this 
location in the search” checkbox.  Use the Browse button to select the folder where the USB 
FTDI drivers were extracted in Step 1 above, and then click Next. 
 
The installation of the drivers will begin.  A window as shown in Figure A-5 will appear 
confirming successful installation of the USB Virtual COM Port drivers (called a USB Serial 
Converter by Windows).   
 

 
Figure A-5 
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STEP 3. Determine USB Virtual COM Port setting. 
 
After Step 2 is complete, the USB Virtual COM Port should be installed.   This will make the 
USB connection to the data logger behave as a Windows serial port, otherwise known as a 
COM port.  To verify this, leave the USB port on the PC connected to the COM connector on 
the data logger.  Now go to the Windows Control Panel (accessible from the Start Menu).  In 
the Classic View mode, the Control Panel window will look something like that shown in 
Figure A-6. 
 

 
Figure A-6 
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Select System to open up the System Properties window, shown in Figure A-7. 
 

 
Figure A-7 
 
Select the Hardware tab to reveal a window of the form shown in Figure A-8.  
 

 
Figure A-8 
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Select Device Manager and look for an entry under Ports (COM & LPT) which corresponds to 
the USB Virtual COM Serial Port.   It will look like any other COM port, but will generally be 
assigned a number higher than 2.  i.e., COM3 in Figure A-9 below.  
 

 
Figure A-9 
 
If multiple serial ports show up, simply unplug the USB cable from the COM port on the Q-
DL-2100 data logger and identify which COM port number disappears.  It should reappear 
when the USB cable is plugged in again.  
 
Note the COM Port number assigned to the data logger USB interface. 
 
To communicate with the data logger you will need to make use of PC based terminal 
emulation software such as Windows HyperTerminal or Tera Term Pro.  See Appendix B for 
setup instructions for these programs.   
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Appendix B: Terminal Emulation Software Setup 
 
There are a variety of terminal emulation software programs capable of communicating 
through the PCʼs COM ports to the Q-DL-2100 datalogger.  Quaesta Instruments has utilized 
both the standard Windows HyperTerminal communication application included with 
Windows as well as a freely available application called Tera Term Pro.  Quaesta 
Instruments personnel generally prefer Tera Term Pro over Windows HyperTerminal 
because of Tera Term Proʼs  configurability of its terminal window.  
 
Before setting up and configuring your chosen terminal emulation application, determine the 
appropriate PC COM port number through which the terminal interface will be implemented.   
 
Two options are available for implementing a terminal interface to the datalogger through an 
RS-232 based terminal interface program.    

1. Connect to the datalogger to a PC utilizing a standard USB A to B cable.  Follow 
the instructions in Appendix A to install the appropriate USB Virtual COM port 
drivers on the PC, and make a note of the PC COM port number assigned to the 
USB Virtual COM port in Appendix A, Step 3.     

2. Connect the Plug end of an appropriately configured cable to the RS-232 interface 
jack available on the back panel.  Connect the alternate end of the cable to the 
PCʼs COM port.  This can be a USB to RS232 cable adaptor.  

 
Using the dataloggerʼs USB COM connector 
When using the dataloggerʼs USB COM connector to implement the terminal interface, the 
PCʼs virtual COM port should be set up with the following parameters: 
 Baud Rate:   115200 
 Data Bits:  8 
 Parity:   None 
 Stop Bits:  1 
 Flow Control:   None 
  
Using the dataloggerʼs RS232 interface connector 
 
When using the RS-232 port terminal interface connector to implement the terminal interface, 
the UseSatModem, UseRS232, and RS232BaudRate INI parameters should be configured 
as follows: 

UseSatModem=0 
UseRS232=1 
RS232BaudRate=19200 (baud rate must be greater than or equal to 19200) 
 
the PCʼs COM port should be set up with the following parameters: 

 Baud Rate:   should match the RS232BaudRate INI parameter 
 Data Bits:  8 
 Parity:   None 
 Stop Bits:  1 
 Flow Control:   None 
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B.1 Windows HyperTerminal Communications Setup 
 
Open the Windows HyperTerminal application (accessible from Start->All Programs-
>Accessories->Communications->HyperTerminal).  
 
Upon first use of HyperTerminal, a “Location Information” window of the form shown in 
Figure B-1 will appear.  

 
Figure B-1. 
 
Simply enter anything in the area code box and click OK (this screen is not relevant for our 
work as we will not be using a modem). 
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You will be presented with a “Connection Description” window of the form shown in Figure 
B-2.    
 

 
Figure B-2. 
 
Enter a name for the connection and click OK. 
 
At the “Connect To” window, shown in Figure B-3, select the appropriate COM Port 
(determined in Appendix A, Step 3 if using the dataloggerʼs USB COM port) from the 
“Connect using: ” pull-down list.  
 

 
Figure B-3.  
 
Select OK and a window similar to Figure B-4 will be displayed.  Select the appropriate COM 
port parameters depending on whether the dataloggerʼs USB COM port or the RS-232 
interface jack is being used for the terminal interface.  
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Figure B-4. 
 
Click Apply and then OK. 
 
For use as a terminal interface, the user will find it useful to further configure the 
Hyperterminal display. 
 
Setting the Font 
To change the Font select View-> Font… from the main menu to display the Font 
configuration Window as shown in Figure B-5.   
A Font Size of 9 works well. 
 

 
Figure B-5. 
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Setting the Terminal Emulation 
Select File->Properties and then select the Settings tab.   Select VT100 for Emulation.  Make 
sure the “Backscroll buffer lines” parameter is set to 500, the maximum number.   
 

 
Figure B-6. 
 
Setting the Terminal Properties 
Select the “Terminal Setup…” button in the Connection Properties window (displayed in 
Figure B-7.  A window titled “Terminal Settings” will be displayed.  Configure it for 132 
column mode as below.    
 

 
Figure B-7 
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Saving the HyperTerminal Configuration 
To Save a configuration for rapid recall,  select File->Save or Save As… as appropriate to 
save the current Hyperterminal configuration. 
 
When starting Hyperterminal (after the first use) one will see the “Connection Description” 
window shown in Figure B-8. 
 
Opening or Recalling a Saved Hyperterminal Configuration 
Upon starting up Hyperterminal the window in Figure B-8 may be displayed.  
 

  
Figure B-8 
 
Select Cancel, and select the File-> Open menu item from the Hyperterminal menu.  Select a 
previously saved Hyperterminal configuration (as in Figure B-9) and all the settings 
previously saved in the selected configuration should be loaded for you.  
 

  
Figure B-9 
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B.2 TeraTerm Pro Communications Setup 
 
Tera Term Pro is an open source free software terminal emulator (terminal communication 
application) for MS-Windows.  It provides for a very convenient means of communicating with 
the Quaesta Instrument Q-DL-2100 datalogger, and its displayed output can be more easily 
configured than Windows Hyperterminal.    

An alternative is the Windows Hyperterminal program if using Windows 2000 or 
Windows XP.  Windows Hyperterminal is no longer available in Windows Vista.  

 
See Steps 1-4 below to install and set up Tera Term Pro on a Windows 2000 or Windows XP 
machine.   
 
Step 1. Installation  

Unzip the file tterm23.zip file into a subdirectory of your choice.  This zip file may be 
downloaded from the internet or can also be obtained from Quaesta Instruments LLC 
personnel.    
 
Step 2. Run setup.exe.   

Follow directions in the Windows installer screens. 
 

Step 3.  Starting Tera Term. 
     Select the Tera Term Pro application from the Windows Start Menu.   
     Figure B-10 shows a main window for Tera Term Pro.  
 

 
Figure B-10.  
 
Step 3.  Setting up a Connection.   
     Upon startup, one may be prompted with a New Connection window as in Figure B-11.  
Select Serial for the connection type and the appropriate serial port number and click OK.  
Note that if using the dataloggerʼs USB COM port to communicate with the datalogger the 
Port number must match the dataloggerʼs USB Virtual Serial port number as found in 
Appendix A, Step 3. 
 



Q-DL-2100 Operatorʼs Manual    

Quaesta Instruments, LLC   (520) 449-3806   •  Email: support@quaestainstruments.com 35 

 
Figure B-11.  
 
Step 4.  Configuring the Terminal.   
     Select Setup->Terminal… from the main menu.   Configure as in Figure B-12.   
 

 
Figure B-12.  
 
Step 5. Configuring the Terminal Display Window. 

Select Setup->Window… from the main menu.  Configure as in Figure B-13. 
  

 
Figure B-13.  
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Step 6. Configuring the Serial Port parameters.   
    Select Setup->Serial Port from the main menu.   

a. If using the dataloggerʼs USB COM port, configure the parameters as in 
Figure B-14.  *Note that the Port number selected must match the 
dataloggerʼs USB Virtual Serial port number as found in Appendix A, 
Step 3.   

b. If using one of the dataloggerʼs RS-232 interfaces for the Terminal 
connection available via the RJ45 connector labeled RS-232 on the 
datalogger backpanel, configure the parameters as appropriate.  In this 
case, the INI parameters “UseRS232” and “UseSatModem” must be set to 1 
and 0, respectively.  The baud rate defined by the INI parameter 
“RS232BaudRate” should then be used in the RS232 port configuration.  

 

 
Figure B-14. 
 
One may save and restore Setup parameters by selecting the appropriate commands from 
the Setup menu.  
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Appendix C: Upgrading the Q-DL-2100 Firmware 
 
The Q-DL-2100 datalogger firmware includes a bootloader program which allows for user 
upgrades of the firmware in the field (if necessary). 
 
To upgrade the firmware on the Q-DL-2100 datalogger the user should follow the steps 
below:   

1. Obtain the latest QDL2100.bin firmware from Quaesta Instruments personnel.   Please 
contact Quaesta Instruments via email at support@quaestainstruments.com or phone 
at (520)449-3806 to obtain the appropriate file.   

2. Turn off the datalogger power and remove the SD card. 
3. Copy the obtained QDL2100.bin file to the top level directory of an available SD card 

(this can be the SD card removed from the datalogger in Step 2). 
4. Insert the SD card containing the QDL2100.bin file into the datalogger. 
5. Turn on the datalogger power. 
6. The dataloggerʼs heartbeat LED should first flash rapidly for approximately 8-10 

seconds while the firmware binary file is detected on the SD card and then copied into 
the dataloggerʼs program space.  After successful copying of the firmware file, the 
datalogger should reboot, executing the new firmware.  The heartbeat LED should 
begin flashing at approximately a 1 second cadence for a few seconds.  Then the 
datalogger will execute a self test of the data acquisition system (with the second 
status LED on during the data acquisition process), after which time the heartbeat 
LED will begin flashing at a cadence of approximately once every 8 seconds. 

7. The firmware is now upgraded.  
 
Follow these additional steps to restore the datalogger to full operation. 
8. Turn the datalogger power off. 
9. Remove the SD card from the datalogger. 
10. Remove or rename the QDL2100.bin file from the SD card if the same SD card is to 

be used for datalogger operation. 
11. Reinsert an SD card with an appropriate QILogger.ini file on it (make sure the SD card 

does not contain a QDL2100.bin file in the top directory). 
12.  Turn on the datalogger.  The sequence described in Step 6 above should repeat, with 

the heartbeat LED rapidly flashing at startup while the bootloader searches for a 
QDL2100.bin file.  If none is found, the datalogger will run the resident firmware.  

  
*Note:  It is not necessary to utilize a terminal emulation program such as Hyperterminal or 
Tera Term Pro to upgrade the firmware.   However, such terminal emulation programs may 
be useful to verify the operation and installation of the firmware as informational messages 
such as the firmware version number are displayed on the terminal interface upon datalogger 
startup. 
 
Upgrading Multiple Data Loggers. 
 
If upgrading the firmware in multiple loggers, repeat the steps above for each data logger to 
be upgraded.  
  
 


